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10835 N. 25th Ave., Suite #350 

Phoenix, AZ 85029 

Phone: 602-866-8199 (x2 for Support) 

Fax: 602-866-9525 

Web:  www.usadsi.com 

 

What’s New in Impact/SQL ver 10.8? 

USA Digital Solutions, Inc. has made some enhancements and bug fixes to Impact/SQL with version 10.8.  The 

enhancements and bug fixes are detailed in this document, and will be incorporated into updates of the module 

manuals, as applicable. 

Escrow 

 
 

1) For CDF files, a new Selection is now available on the print screen to allow for ‘Both’ Borrower & Seller 

statements to be generated.  The option for seller signatures will also be present for selection when an 

External version is selected.  (SRS #44141)  

 

 

 

 

 

 

 

  

http://www.usadsi.com/
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2) The File History log has been updated to include a reference with description, when the Type of Closing, 

entry type has been modified.  The reference will also include the previous and new values.  Use the  

History icon or File > View Escrow History to view.  (SRS #44218) 

 

 

 

 

 

 

 

3) When a CD file was opened from a master file and the escrow officer name was modified, the contact page 

of the CD was not being updated to reflect the escrow officer designated in the file.  This is now corrected. 

(SRS #45660) 

 

4) )The following Zip code / City additions have been added: 

Zip Code 94608 now has options for Oakland and Emeryville.  (SRS # 45712) 

Zip Code 94553 now has options for Martinez, Pacheco and Briones.  (SRS # 45712) 

Zip Code 86005 now has an option for Flagstaff, AZ.  (SRS # 45920) 

 

5) The receipt reports can now be semi-customized to allow for an electronic signature of the user to be 

automatically added when printing.  Each user will need to provide an e-signature sample to be attached to 

their user account by local IT.  (SRS #45754) 

 

6) The certification stamp location on the ALTA Settlement Statements has been moved so as not to interfere 

with a long borrower and/or seller name. (SRS # 46000) 

 

7) In a CDF file, when the Lender’s Policy was marked as Simultaneous Issue and the discount was greater than 

the Base Premium of the Owner’s Policy, the Owner’s Policy did not appear on the Fee Check Invoice.  This 

issue has been corrected in 10.8 and the Owner’s Policy Premium will be presented on the Fee Check 

Invoice.  To recreate, enter a loan policy base premium of $1000 and mark as Simultaneous issue with a 

$700 discount, charging the seller $300.00.  Enter an Owner’s Policy premium of $500 charging the seller.  

Print/Preview the Fee Check Invoice (Disburse>Fee Check Invoice) and confirm that both the loan and 

owners policy are presented.  (SRS #46140) 
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8) In a CDF file when the borrower is paying any portion of the Owner’s Policy Premium the CDF description 

must include the word (Optional) i.e. “Title – XXXXX Owner’s Policy (Optional) to XXXXXXX” per the rule.  

The word ‘Optional’ is not required in the description on other documentation such as the settlement 

statement.  Impact will now provide an alternate description on all other reports/documents.  To recreate, 

in a CDF file enter an Owner’s Policy charging both the buyer and seller a portion of the premium.  

Print/Preview the CDF and the OTP description should include OPTIONAL in the description.  Print/Preview 

the Impact settlement statement and the description should NOT include the word OPTIONAL. (SRS #46158) 

 

9) The User Attachments widget will now support PNG files.  (SRS #46253) 

 

10) In HUD w/GFE files, the Endorsement Description field has been expanded to allow for 50 characters.  (SRS 

#46196)  HUD w/GFE file > Section 1100 > Open Line 1104 via the icon > add NEW ITEM for endorsement.  

 
 

11) The CDF Payee selected via the binoculars icon will now display an individual’s name as First Middle Last on 

the Payee Information section of the charge item.  (SRS# 44039) 

 

 
 

12) The wiring information entry screen for payoffs has been modified in Commercial and CDF files.  The full 

wire details can now be entered once the item has been marked to be a wire disbursement. (SRS #45568) 

 

13) When a payoff that is indicated as the first payoff is deleted, when user adds a new payoff marked as a first 

payoff they are presented with the message “This will replace that item as the new Payoff First Mortgage 

entry.  Do you wish to continue?". (SRS #46173) 

 

14) In CDF files, there is a new print option selection to show the breakdown of seller credits to Borrower on the 

Settlement Statement.  (SRS #45661) 

  



What’s New in Impact/SQL 10.8_General Page 4 04/13/2017 

 

15) In CDF files, the print options have been modified to eliminate all LABELS and signature lines associated 

when the INTERNAL selection is made.  The additional labeling was not supported by the CFPB RULE and 

preliminary versions should never be signed by the parties to the file.  (SRS #45449) 

 

16) A new print option has been added to allow for the selection of “Show Breakdown of Commissions” on the 

Settlement Statement.  (SRS #45777) 

 

17) The Disbursements screen has been modified to allow the header information to remain visible when the 

user selects a different tab to view the Pending Wires, Receipts, Checks, Wire Outs and Receivables (if so 

configured).  (SRS #46095) 

 

18) A new DDE field has been made available on the GENERAL tab for the property state to be spelled out 

instead of abbreviated.  (SRS #46202)  From the Impact MS-Word toolbar select DDE and search for Property 

State on the General tab. 

 

19) When searching the Documents menu, Impact will now include the header information as it did in previous 

versions.  (SRS #46383). 

 

20) The Invoice screen (File > Invoicing > add/modify) will now include the display of the user’s initials that 

created the invoice. (SRS #46229) 

 
 

21) The functionality on the payoff screen has been cleaned up.  In 10.6, on the payoff screen the default is now 

set to per diem for the Prorate By: field as requested and now allows the user to click on calculate without 

the presentation of a pop-up message.  (SRS#46377). 
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22) Tax ID numbers are able to be entered on all buyers and sellers; they are seen in several places, including 

the 1099-S screen.  The masking of tax ID numbers (SSN, EIN, TIN), on the display and on standard reports 

and documents (including the 1099-S), is now an available option in 

Impact/SQL.  The masking will replace the first 5 digits of the 

number with asterisks (*), and will present the final 4 digits 

normally.  (SRS #45835) 

 
There is one Setup Option change, discussed in the Utilities section below, that must be made to enable tax 

ID number masking.  An additional control, also detailed in the Utilities section below, provides for user-level 

masking of tax ID numbers on the display...so that selected users will see the full tax ID numbers on their 

screens when editing a file, while others will not.  If a user does not have the Unmask SSN, TIN and EIN on 

Edit option enabled on their Impact initials, they will not see the full number after entry, and if they are 

unsure if the number is correct, will need to re-enter it carefully and completely to make sure it is correct.  

The number is seen in its entirety while being entered.   

 

Because the Title Instructions (CRW-based) are “semi-custom” reports (potentially different on each site) 

they must be modified, after the upgrade, to present the masked SSN, EIN, or TIN numbers.  A new 

“formula” is made available to the Crystal Report editor for the masked number.  Any custom reports that 

present these numbers will need to be edited as well. 

 

23) Additional and enhanced functionality has been added to the Signature Tabs as applicable for Buyer, Seller 

and Accommodator parties to facilitate the entry of multiple “custom signatures” per party entity.  Custom 

Signatures allow the user the flexibility to enter information both above and below the signature line.  

Multiple signatures can now be added to a single party and the users are able to rearrange the position of 

the signatures by moving them up or down in the list.  (SRS #45641) 

 

Existing functionality remains unchanged when the custom signature tab is not used.  The signature will 

present and match the entries on the Information tab for first, middle and last name fields on 

documentation/statements. 

 
 

In the event a Custom Signature or multiple signatures are needed for the Party clicking on the Signature(s) 

Tab will bring up the custom signature entry screen.   
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Clicking the Add New Signature icon will open the Add 

Custom Signature entry screen allowing the User to 

enter Custom Signatures both above and below the 

signature line. 

Clicking OK will save the entries and return the User to 

the Signature(s) Tab, clicking Cancel will not save the 

entries and return the User to the Signature(s) tab. 

To add additional signatures to this Party click the Add 

New Signature icon and repeat the entry process 

described above.  Click OK to return to the Signature 

Tab.  

 

 

Use the Move Up and Move Down icons to adjust the position of the signatures as needed.  When finished 

adding / editing signatures for this Party click   to return to the Parties Screen. 

 

24) A new option has been added to the Pending Wires tab, found in Disbursements, to allow the user click the 

‘X’ icon to DELETE a wire item without first changing it to a disbursement.  (SRS #46418) 

 

25) Wire prep functionality is now available for Sub-Agent Commission disbursements.  A new check box for 

‘Issue Wire’ has been added to the sub-agent entry screen that activates the ellipsis icon.  Clicking on the 

ellipsis will open the wire information screen.  (SRS #46431) 
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26) The liability field on the title insurance premium screen is now available for users to manually enter the 

amount when an income code is not selected.  This liability amount would then be available for the 

settlement statement verbiage relating to the charge. (SRS #45643) 

 
 

 

Escrow & Title 

1. The Invoices in Impact will now allow for an unlimited number of record lines.  Previously, the invoice was 

limited to 30 lines.  (SRS #45443). 

 

2. The Email options screen has been enhanced to now display the Party an Attorney reference is representing 

for easy identification by the user.  SRS# 31288 

 
 

3. When a user accesses the Escrow Documents Menu or the Title Document menu, the focus of the cursor is 

in the filter box.  This allows the user to start typing the document name immediately.  (SRS #46365). 

 

Accounting  
1) A new setup option now allows for Custom Reporting to be made available in the Accounting Module.  

(SRS #46269) 

 

2) The SQL tables, Disbursements.Payee_Name and OpnChk.Payee_Name have been increased to 104 

characters to match the Payee Name length.  And SQL table Opnchk.Description has been increased to 

50 characters.  This will now allow the full 104 characters to be included in the positive pay file and for 

WMA Positive pay integration.  (SRS #44921)  To test, disbursements with 104 character payees should 

be issued and then produce a positive pay file to confirm the full payee is included. 
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Title 
1. On the Policy Entry screen the TYPE field has been expanded in order for the full Policy description to be 

presented.  Title Module > edit policy icon.  (SRS #45653). 

 

 

 

 

 

 

2. A new setup option now allows for Custom Reporting to be made available in the Title Module.  (SRS 

#46269) Utilities > Setup Options > Title functions > Miscellaneous > Enable Title Custom Reports 

 

3. When the Prelim/Commitment is setup to include the Title Charges, charges with a 0.00 amount are not 

being reflected.  This has been corrected and the 0.00 charge items will be presented on the 

Prelim/Commitment. (SRS #46924) 

 

UTILITIES 

 
1) Utilities> User Tables > Property Descriptions > Cities:  A new filter is available to assist with the selection of 

a City name from the Maintenance table. (SRS #44516). 
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2) Utilities > User Tables > Property Descriptions > Counties:  A new filter is available to assist with the 

selection of a County name from the Maintenance table. (SRS #44517). 

 
 

3) A new setup option now allows for Custom Reporting to be made available in the Accounting and Title 

Modules.  (SRS #46269) Utilities > Setup Options > Accounting functions > Miscellaneous > Enable 

Accounting Custom Reports // and Utilities > Setup Options > Title functions > Miscellaneous > Enable 

Title Custom Reports. 

 

4) The County Tiered Tax Rates configuration will now accommodate 5 tiers of fees instead of only 4.  This was 

necessary for San Francisco County.  (SRS #46081).  To access the configuration screen- User Tables >  

Property Descriptions > Counties > enter a county into the filter selection and click Filter Results > click on 

the pencil icon to open the Modify county window, where the tiers are referenced. 
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5) The masking of tax ID numbers is enabled, in the Utilities module, via System Files, Setup Options, General 

Functions, Miscellaneous, Enable Masking of SSN, TIN and EIN.  This option will default, at the time of the 

v10.8 upgrade, to a disabled state, and will have to be checked to enable the masking function, if the 

business wishes to use the function.  Enabling this option will also provide for the user-level control 

discussed in the next item. 

 

 

 

 

 

 

 

 

 

 

 

6) When the Enable Masking of SSN, TIN and EIN setup option is enabled 

(discussed above), there will be a user-level option, managed through the 

Utilities module, System Files, Users, that can be used to allow for specific 

users to see the full SSN, TIN, or EIN, on buyers and sellers, when they are 

editing a file, rather than viewing just the masked number (first 5 digits will be 

asterisks, the last 4 displayed).  If a user does not have the Unmask SSN, TIN 

and EIN on Edit option enabled on their Impact initials, they will not see the 

full number, and if they are unsure if the number is correct, will need to re-

enter it carefully and completely to make sure it is correct. 

 

Impact Windows Service 

 
1) Scheduled Reports and Background Printing; the list of printers the user can select from includes XPS, 

OneNote, PDF and FAX when they should not be presented. This has been corrected and the XPS, OneNote, 

PDF and FAX printers are no longer presented.  (SRS #46858) 


